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1 INTRODUCTION 

This test plan covers the EMC (Electromagnetic Compatibility) and EMI 
(Electromagnetic Interference) test requirements and methods for the Hart 
InterCivic Verity Vanguard 1.0 voting system, hereafter known as the Equipment 
Under Test (EUT), to the requirements as stated in Election Assistance 
Commission Voluntary Voting System Guidelines Version 2.0 (EAC VVSG 2.0). 

1.1 Qualifications 

The EUT supplied by Hart InterCivic is representative of product produced in 
their volume manufacturing process. 

1.2 Hardware Test Lab Facility   

Element Materials Technology Denver-Longmont 
1736 Vista View Drive 
Longmont, Colorado 80504 

1.3   Reference Documents 

1. Election Assistance Commission Voluntary Voting System Guidelines 2.0 
2. Election Assistance Commission Voluntary Voting System Guidelines 

(VVSG) v 2.0, Test Assertions v 1.3 
3. NIST Handbook 150-2020 
4. NIST Handbook 150-22-2021 
5. Election Assistance Commission Voting System Testing and Certification 

Program Manual, United States Election Assistance Commission, v 3.0 
6. SLI Compliance VSTL Quality System Manual, Rev. 4.1 Aug. 14, 2023 

2 Product Description 

2.1 Intended Use 

The EUT is intended to be used in the polling place environment. 
 

2.2 Equipment Under Test 

Product/Model Serial Number Description Qty 

Vanguard Boost 

 

 

B2520006401 

 

 

Vanguard Boost (Polling Place 
Ballot Issuance) is a poll worker 
facing device designed to improve 
voter service by optimizing ballot 

1 
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2007020 

Rev A Reg: VV-500 

 

B2520006001 

(Backup Unit) 

issuance in the polling place. 
Vanguard Boost can be utilized by 
poll workers in two ways. Boost may 
be used to print blank paper ballots 
on demand, using an attached ballot 
printer. Boost may also be used to 
issue VotePasses, which allow voters 
to access, mark, and print a printed 
vote record using Vanguard Flex or 
Adapt. Vanguard Boost does not 
store vote data. 

Vanguard Flex 

 

2007010 

Rev A Reg: VV-400 

F252000401 
(Original Unit) 

 

F252000501 

(Backup Unit) 

 

 

 

Vanguard Flex (Polling Place BMD) 
is a universal ballot marking device 
that produces an auditable summary 
ballot of a voter's choices. Voters can 
mark their ballots using the 
touchscreen interface or a wide 
variety of accessible controls. Printed 
summary ballots are then scanned in 
Verity Vault for tabulation. 

2 

Vanguard Vault with 
Imprinter 

 

2007030 

Rev A Reg: VV-600 

V2520003701 

 

Vanguard Vault (Polling Place 
Precinct Scanner) is a polling place 
scanning device that captures voter 
choices whether using ballots marked 
by hand or machine, including 
summary ballots (printed vote records 
(PVRs)). 

1 

Vanguard Adapt 

 

2007040  

Rev A Reg: VV-700 

A2520009001 Vanguard Adapt (Polling Place 
Limited Dexterity Mark, Verify and 
Cast Device) is an all-in-one voting 
device that produces an auditable 
summary ballot of a voter's choices. 
Voters can mark their ballots using 
the touchscreen interface or a wide 
variety of accessible controls. 
Vanguard Adapt enables voters to 
mark, verify, and cast their ballot all 
without touching a piece of paper. 

1 

2.3 Power Requirements 

 
AC mains Yes 
Input Voltage Rating as it appears on unit, power supply, or power 
brick 

100 ~ 240Vac 

Flex - Input Current (specify @ 230 Vac/50 Hz) 0.5 A 
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Adapt - Input Current (specify @ 230 Vac/50 Hz) 0.5 A 
Boost - Input Current (specify @ 230 Vac/50 Hz) 0.25 A, 2.25 A with 

HP LaserJet Pro 
4001dn series 
printer in BOD 
mode 

Vault - Input Current (specify @ 230 Vac/50 Hz) 0.25 A 
Input Current (specify @ 230 Vac/50 Hz) 0.7 A 
Single or Multi-Phase (If multi-phase, specify delta or wye) Single 
Input Power connector a 2-prong, 3-prong, 4 prong or 5 prong plug 3-prong 
Does UUT have more than 1 power cord?  Adapt has 2 power 
cords. Boost requires 2 power cords in BOD mode. 

No 

2.4 Support Equipment (SE) 

Product/Model Serial Number Description Qty 

Vanguard Imprinter I2520013501 Optional Vault accessory that is 
designed to better support a ballot-
level risk limiting audit (RLA). The 
imprinter prints a unique ID onto 
the ballot after the ballot has been 
cast. This ID enables searchability 
and 
traceability at the individual ballot 
level. 

1 

Accessibility Controller Part No. 
2007080-A 

Optional accessibility controller for 
users with low dexterity. 

3 

Two-button switch Part No. 
10033406 

Optional attachment to the 
accessibility controller for users 
with greater dexterity challenges. 

3 

Headphones (COTS) Part No. HA310 Optional attachment to the 
accessibility controller for users 
with visual impairments. 

4 

Motorola/Zebra DS4308 
handheld AutoBallot 
COTS barcode scanner 

 

 

N/A 

 

Optional device to activate ballot 
style is based on the barcode 
generated by a pollbook on check-
in. Used with Vanguard Boost, 
Flex, and Adapt 

3 

HP LaserJet Pro 
4001dn series mono 
laser printer (COTS) 

VNL0341878 
 Optional COTS printer for printing 

blank paper ballots for use with 
Vanguard Boost. 

1 

HP Officejet 200 
(COTS) 

N/A COTS laser printer for printing 
blank paper ballots for use with 
Vanguard Adapt 

1 
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Ballot Box X2520014901 Purpose made plastic, collapsible 
ballot box for use with Vanguard 
Vault. 

1 

2.5 EUT Software/Firmware 

Name Version Functionality 

Vanguard Software (all) 1.0  Election software for operational status check. 

2.6 Accessories 

Type Model Function 

Test Ballots N/A Pre-mark Test Ballots 

Verity Key - Security Key N/A User authentication and configuration of 
election security. 

Verity vDrive  N/A Load election definitions, record CVRs and audit 
logs. 

3 Equipment Under Test 

Backup units of the same model with unique serial numbers may be used 
throughout EMC/EMI testing provided the following criteria are met: 

 Issue with EUT.  
 Identical hardware. 
 All hardware components are listed in Manufacturer’s BOM or APL. 

3.1 Operating Modes and Test Configurations  

Prior and during testing, proper operation of the EUT shall be confirmed using 
Hart InterCivic software. An operational status check shall be performed prior 
to and after each test to fully exercise the EUT and ensure that no damage has 
occurred as a result of the test. 

To fully exercise all the features of each product, test software is run during 
electrical tests to exercise the model’s particular hardware features.  

 

- Vanguard Adapt 
 AutoBallot barcode reader connected via obfuscated USB ports  
 Remaining external USB ports are covered with USB inserts 
 Headphones 
 Jelly Switch 
 Floor Standing 
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HP OfficeJet 200 (Support equipment) 
 Loaded with Ballot stock 
 Mounted on top device 
Additional Materials needed during EMC Test 
 Test CFast card (Win10 Vanguard MVT 1.0.0) 
 vDrive for EMC testing 
 USB mouse 
Setup for EMC Testing 
 Replace the Verity Vanguard 1.0 CFast with the Test CFast card. 
 Replace vDrive with election with vDrive for EMC testing. 
 Plug in a USB mouse 
 Turn on device. 
 The display will be flipped.  Right-click on the desktop and click on 

Display settings on the pop-up menu. 
 Under Display Orientation set it for Portrait (flipped) 
 Open folder on desktop titled Adapt 
 Double tap button Run In Seiko Printer icon. The thermal report printer 

will print every 300s for up to 40 hours.  
 Double tap File IO Test icon. The vDrive for EMC testing will have 100 

bytes of data written to it every 5 seconds for up to 20 hours. 
 Double tap Audio 8 Hrs. icon. Audio will play on the headphones for up 

to 8 hours.  
 Double tap ATI Test icon. Validate the function of the ATI by pressing 

buttons using rotating the scroll wheel. 
 Double tap Scanner Diagnostic icon. 

o Hit Connect, located just below the File menu 
o Under Sides Scanned set to Front Only. 

 Double tap HP OfficeJet 200 – 100 sheets icon. The laser printer 
will print a sheet every 5 minutes for up to 8 hours.  

 Remove mouse and lock vDrive door. 
 Device is now ready for testing. 

- Vanguard Boost 
 AutoBallot barcode reader connected via obfuscated USB port 
 ATI Connected via obfuscated USB port 

 Headphones 
 Jelly Switch 

 Tabletop 
HP Laser Jet Pro 4001dn series mono laser printer (support 
equipment) 
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 Loaded with Ballot stock 
 Tabletop 
Additional Materials needed during EMC Test 
 Test CFast card (Win10 Vanguard MVT 1.0.0) 
 vDrive for EMC testing 
Setup for EMC Testing 
 Replace the Verity Vanguard 1.0 CFast with the Test CFast card. 
 Replace vDrive with election with vDrive for EMC testing and lock vDrive 

door. 
 Turn on device.  
 Open folder on desktop titled Boost 
 Double tap button RunIn Seiko Printer icon. The thermal report printer 

will print every 300s for up to 40 hours.  
 Double tap File IO Test icon. The vDrive for EMC testing will have 100 

bytes of data written to it every 5 seconds for up to 20 hours. 
 Double tap Audio 8 Hrs. icon. Audio will play on the headphones for up 

to 8 hours.  
 Double tap ATI Test icon. Validate the function of the ATI by pressing 

buttons using rotating the scroll wheel. 
 Double tap HP Laser Jet Pro 4001dn – 100 sheets icon. The laser 

printer will print a sheet every 5 minutes for up to 8 hours.  
 Device is now ready for testing. 

- Vanguard Flex 
 AutoBallot barcode reader connected via obfuscated USB 
 ATI Connected via obfuscated USB 

 Headphones 
 Jelly Switch 

 Remaining external USB port is covered with a USB insert 
 Floor Standing on Accessible Booth 

Additional Materials needed during EMC Test 
 Test CFast card (Win10 Vanguard MVT 1.0.0) 
 vDrive for EMC testing 
 PVR Stock 
 USB keyboard 
Setup for EMC Testing 
 Replace the Verity Vanguard 1.0 CFast with the Test CFast card. 
 Replace vDrive with election with vDrive for EMC testing. 
 Insert keyboard into a USB port in vDrive Bay.  
 Turn on device.  
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 Open folder on desktop titled Flex 
 Double tap button RunIn Seiko Printer icon. The thermal report printer 

will print every 300s for up to 40 hours.  
 Double tap File IO Test icon. The vDrive for EMC testing will have 100 

bytes of data written to it every 5 seconds for up to 20 hours. 
 Double tap Audio 8 Hrs. icon. Audio will play on the headphones for up 

to 8 hours.  
 Double tap ATI Test icon. Validate the function of the ATI by pressing 

buttons using rotating the scroll wheel. 
 Prepare the internal PVR printer for shoeshine printing 

 Double click on the TP850 shortcut.  The PVR Batch Printing screen 
displays. 

 Within the PVR Batch Printing application hit the Connect button and 
wait for the “Connected” status on the bottom left to become green. 

 Hit Set Defaults. 
 Check that the Paper Size radio button is 11” or 14”, depending on 

the PVR blank sheet you will be using. Either is fine. 
 Under Paper Handling, select Stop, and then hit Set. 
 Hit Enable and wait for the “Enabled” to become green. 
 Hit Shoeshine button and hit OK on the paper exit handling prompt. 
 Set the Frequency to 300 seconds.  
 Set the Reverse Line Count to 5. 
 Set the Repeat to 5. 
 Hit Start Print Test.  Insert paper with the arrows facing the screen 

and hit OK on the prompt. 
 The printer will print and work the motors every 5 minutes until the 

Stop button is pressed.  
 Remove keyboard and lock vDrive door. 
 Device is now ready for testing. 

- Vanguard Vault with optional Imprinter accessory 
 Floor Standing on Ballot Box 
 ATI Connected via obfuscated USB 

 Headphones 
 Jelly Switch 

 Remaining external USB ports are covered with USB inserts 
Additional Materials needed during EMC Test 
 Test CFast card (Win10 Vanguard MVT 1.0.0) 
 vDrive for EMC testing 
 Ballot Stock 
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 USB keyboard 
Setup for EMC Testing 
 Replace the Verity Vanguard 1.0 CFast with the Test CFast card. 
 Replace vDrive with election with vDrive for EMC testing. 
 Insert keyboard into a USB port in vDrive Bay.  
 Turn on device.  
 Open folder on desktop titled Vault.  
 Double tap File IO Test icon. The vDrive for EMC testing will have 100 

bytes of data written to it every 5 seconds for up to 20 hours.  
 Double tap Audio 8 Hrs. icon. Audio will play on the internal speaker for 

up to 8 hours.  
 Double tap RunIn Seiko Printer icon. The thermal report printer will print 

every 300s for up to 40 hours. 
 Double tap Platform Manager Tests icon. Wait for window to open and 

tap the Radio button under Scanner LEDs Set Ready to Scan.  
 Double Tap Scanner Diagnostic icon. 

a. Hit “Connect”, located just below the “File” menu. 
b. Hit the Options tab. 
c. Hit the checkbox Enable Recycle Mode. 
d. Hit the checkbox No Image Display. 
e. Use the keyboard to change Rescan delay to 15500 
f. Place a ballot into to Verity Vanguard Vault. It will repeatedly feed the 
same ballot (shoeshine) without fully dropping it into the box. 

 Remove keyboard and close cover of vDrive bay and lock vDrive door. 
 Device is now ready for testing 
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3.2 Block Diagram 

 
Verity Vanguard Adapt 

 

 
 

 
 
Verity Vanguard Boost  
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Verity Vanguard Flex 
 

 
 
 
 
 
Verity Vanguard Vault 
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3.3 Treatment of Test Failures 

Failures of electrical tests or failures of the exercising software to perform shall 
be documented in the electrical test report. 

3.4 Backup Unit 

Backup unit of the same model with unique serial numbers may be used 
throughout EMC/EMI testing provided the following criteria are met:  

 Issue with the EUT.  
 Backup unit is identical to the EUT. 
 All hardware components are listed in Manufacturer’s BOM or APL. 

3.5 Test Documentation 

A test report shall be obtained from the test lab that meets the pertinent 
requirements ISO/IEC17025 (E), “General Requirements for the Competence of 
Testing and Calibration Laboratories”, 2017-11. 

4 EMC/EMI Test Requirements 

4.1 Electromagnetic Emissions 

Objective: To verify that the electromagnetic emissions generated by the 
product under normal use and in the product’s intended environment are below 
a level as specified by FCC Federal Communications Commission, Part 15; 
Class A or B requirements for radiated emissions by testing per ANSI C63.4-
2014.  

Class A is utilized for non-polling locations, and Class B is utilized for polling 
locations. 
 
1.2-I – FCC Part 15 Class A and B Conformance  

The voting system MUST comply with the Rules and Regulations of the 
Federal Communications Commission, Part 15; Class A or Class B 
requirements for radiated and conducted emissions by testing per ANSI 
C63.4-2014. 

The voting system documentation MUST indicate whether devices 
comprising the system are intended to be located in non-polling places 
(Class A) or polling places (Class B). 
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4.1.1 Radiated Electromagnetic Emissions 

Frequency Bands:  
30 MHz - 1 GHz, FCC Part 15. Class B. 
1 GHz - 10 GHz, FCC Part 15. Class B. 

Deviations from Test Method: None 

4.1.2 Conducted Electromagnetic Emissions 

Frequency Bands:  
150 kHz - 30 MHz, FCC Part 15. Class B. 

Deviations from Test Method: None 

4.2 Electromagnetic Immunity 

Objective: To verify that the product performs as intended when exposed to 
different types of electromagnetic energies that may be encountered under 
normal use in the product’s intended environment. 

4.2.1 Electrostatic Disruption 

2.7-K – Electrostatic discharge immunity 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC 61000-4-2 (2008), level 4, applying an air discharge or a 
contact discharge according to the nature of the enclosure of the voting 
system, and without damage, disruption of normal operation, or loss of data. 

Application of electrostatic discharge points to COTS components MAY be 
performed. 

The voting system may cycle power or have momentary interruption of 
power provided that normal operation is resumed without human 
intervention or loss of data. 

Test Level 4:  
 Will not exceed the required ESD limits for all ESD test levels. 

Test Location Test Voltage 

+/- (kV) 

Indirect Contact: HCP  8.00 

Indirect Contact: VCP  8.00 

Direct Contact to Metallic Surfaces  8.00 

Air Discharges to Insulated Surfaces  2.00, 4.00, 8.00, 15.00 

Deviations from Test Method: None 
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4.2.2 Electromagnetic Susceptibility (Radiated RF Immunity) 

2.7-G – Electrical disturbance 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC 61000-4-3 (2020) standard for radiated immunity, without 
disruption of normal operation or loss of data. 

Test Level 3: 

Test field 
strength 
(V/m) 

Frequency 
Range (MHz) 

Modulation/Sweep 

10 V/m  80 to 1000 1 kHz 80% AM, 1% steps with 3s dwell 

Deviations from Test Method: None 

 

 

4.2.3 Electrical Fast Transient (EFT) 

2.7-I – Withstand conducted electrical disturbances 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC 61000-4-4 (2012) standard for electrical fast transient 
protection, without disruption of normal operation or loss of data. 

Note: Repetition Rate for all transient pulses will be 100 kHz 

Test Level 3:  

a. +2 kV and −2 kV on External Power lines (both AC and DC)  

b. +1 kV and −1 kV on Input/Output lines (signal, data, and control lines) 
longer than 3 meters  

c. Repetition Rate for all transient pulses will be 100 kHz  

Deviations from Test Method: None 

4.2.4 Lightning Surge 

2.7-I – Withstand conducted electrical disturbances 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC 61000-4-5 (2014) standard for lightning surge protection, 
without disruption of normal operation or loss of data. 

Test Levels 3-4: Differential Mode – 2kV, Level 3. Common Mode – 2kV, 
Level 4.  

Test Voltage: +/- kV Coupling Mode 

+/- 2 kV AC line to line (Differential Mode) 
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+/- 2 kV AC line to earth (Common Mode) 

+/- 0.5 kV DC line to line >10m (Differential Mode) 

+/- 0.5 kV DC line to earth >10m (Common Mode) 

+/- 1 kV I/O signal/control >30m 

Deviations from Test Method: None 

4.2.5 Electrical Power Disturbance (Voltage Dips) 

2.7-I – Withstand conducted electrical disturbances 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC61000-4-11 (2020) standard for power dips, interruptions, and 
variations immunity, without disruption of normal operation or loss of data. 

Test Class 1:  

 Electrical Power Disturbance 

Voltage dip of 30% of nominal @10 MS;  

Voltage dip of 60% of nominal @100 mms & 1 sec 

Voltage dip of >95% interrupt @5 sec  

Surges of + 15% and – 15% line variations of nominal line voltage  

Electric power increases of 7.5% and reductions of 12.5% of nominal 
specified power supply for a period of up to four hours at each power level  

Deviations from Test Method: None 

 
The voting system MUST not be disturbed by a temporary overvoltage of 
120 % normal line voltage lasting from 3 mess to 0.5 s, applied in gradual 
steps of overvoltage across the line and neutral terminals. 
 
The voting system MUST not be disturbed nor overheat for a permanent 
overvoltage of 10% above the nominal 120 V rating of the voting system, 
applied in gradual steps of overvoltage across the line and neutral terminals. 

4.2.6 Conducted RF Immunity 

2.7-J – Emissions from other connected equipment 

The voting system MUST be able to withstand testing in accordance with 
the latest IEC 61000-4-6 (2013) standard for conducted immunity, without 
disruption of normal operation or loss of data. 
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Test Level 3: 

Conducted RF Energy 

10V rms over the frequency range 150 KHz to 80 MHz with an 80% 
amplitude modulation with a 1 KHz sine wave AC & DC power.  

10V sig/control >3 m over the frequency range 150 KHz to 80 MHz with an 
80% amplitude modulation with a 1 KHz sine wave 

Deviations from Test Method: None 

5 EMC/EMI Test Summary 

The following Table shows the tests to be performed on the UUT.  

Test  Test Specification VVSG 2.0  Comments 
Electromagnetic Emissions Tests  

Radiated 
Electromagnetic 
Emissions  

FCC, Part 15 Class A/B ANSI 
C63.4-2014. Class B [FCC19a] 

1.2-I.1, 1.2-I.2  

Conducted 
Electromagnetic 
Emissions  

FCC, Part 15 Class A/B ANSI 
C63.4-2014. Class B [FCC19a] 

1.2-I.1, 1.2-I.2  

Electromagnetic Immunity Tests   

Electrostatic 
Disruption 

IEC 61000-4-2  2.7-K   

Electromagnetic 
Susceptibility 

IEC 61000-4-3  2.7-G   

Electrical Fast 
Transient 

IEC 61000-4-4  2.7-I   

Lightning Surge IEC 61000-4-5  2.7-I   

Electrical Power 
Disturbance 

IEC 61000-4-11  2.7-I   

Conducted RF 
Immunity 

IEC 61000-4-6  2.7-J  

 

 

End of ELEC Hardware Test Plan 
 


